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Welcome 
Welcome to the Columbia Weather Systems family of users and 
congratulations on your purchase of WeatherMaster software. 

 

Please read this manual completely prior to install ation. 
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Introduction 
Features 
·  Compatible with Capricorn, Pegasus, Orion, Orion LX and Web XML 

data. 
·  Collects data from a single or multiple weather stations connected to 

separate COM ports on the computer or through network connection.  
·  Displays data using multiple XML pages. 
·  Automatically updates a web page for each station using an HTML 

template. 
·  Automatically generates a data export file for each station to upload 

to an FTP sever. 
·  Displays trend chart, min/max and daily statistics for each station. 
·  Prints all views in full report form. 
·  Allows historical data to be viewed in trend, min/max, and daily 

statistics pages. 
·  Allows user-defined parameters for optional sensors. 
·  Provides flexible alarm conditions for individual stations. 
·  Allows multiple alarm conditions and notifications. 
·  Alarm notifications include popup, email, and relay control. 
·  Allows for user defined wind direction offset. 
·  Interfaces with ALOHA software*. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* Area Locations of Hazardous Atmospheres Software 
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Installation 
Software Installation 
Insert CD-ROM in drive. The CD-ROM will auto run and start the 
installation. If not, please double click on the Setup.exe file to start the 
installation. 

Follow the on-screen instructions to finish the installation. 
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Configuration 
Weather Stations 
From the Configuration menu, select Weather Stations. 

 



14 WeatherMasterÔ   
___________________________________________________________________ 

Columbia Weather Systems, Inc. 

Adding a new station 
To add a new station, select the Add button in the Edit Weather Station 
dialog. 

Capricorn/Pegasus and Orion Station Types: 

The Capricorn, Pegasus, and Orion weather stations communicate with 
WeatherMaster via an RS-232 serial communication port (Comm Port). 

If the computer does not have a built-in serial port, a USB to Serial 
converter can be used to create a virtual serial port. 

 

For Capricorn and Pegasus stations, enter the Control Module serial 
number.  

For Orion stations, enter 100 as the serial number. If adding more than 
one station, increment the serial number. 

Enter the weather station location, such as Aloclek Drive, Hillsboro, 
North Runway, Command Center or any other description desired. 

Select the Comm Port to which the station is connected from the drop 
down list. 
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Orion LX and Web Site Station Types: 

The Orion LX weather station communicates with WeatherMaster via the 
Ethernet network using XML data. 

The Web Site station communicates with WeatherMaster via the Internet 
using XML data which is exported to the Internet by the Orion LX 
MicroServer every 15 seconds. 

 

For the Orion LX, enter the serial number of the MicroServer. 

For Web Site stations, enter 100 as the serial number. If adding more 
than one station, increment the serial number. 

Enter the weather station location, such as Aloclek Drive, Hillsboro, 
North Runway, Command Center or any other description desired. 

For Orion LX stations , enter the MicroServer IP address (found on the 
bottom of the MicroServer enclosure). 

For Web Site stations , enter the web address and xml file name, e.g. 
www.columbiaweather.com/commandcenter.xml. 
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Check “Interface to Aloha” to interface WeatherMaster with ALOHA 
(Area Locations of Hazardous Atmospheres) software. If there are 
multiple weather stations communicating with the software, only the first 
station defined will communicate with ALOHA software.  

Use the Add button to add more stations as required. 

Click OK when finished. 

Click Cancel to close the dialog without saving any changes. 
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Software Settings 
Select the Edit button from the Weather Station dialog to change the 
station configuration. 

Capricorn/Pegasus Station Type: 

 

Location description and port settings can be edited. 

If using evapotranspiration, enter the appropriate crop factor. Crop factor 
1 is for a reference crop of Alfalfa.  

Evapotranspiration is calculated using the 1982 Kimberly-Penman 
formula as applied in the U.S. Bureau of Reclamation’s Pacific Northwest 
AgriMet Program. 

Note: In order to correctly calculate Evapotranspiration, the following 
sensors must be installed in the system: 

·  Air temperature 

·  Wind speed and direction 

·  Relative humidity 

·  Solar radiation 

If using Degree-Day, enter the reference temperature to be used in the 
calculations. The Degree-Day reference temperature must be entered in 
degrees F. 

Degree-Day = Average Temperature – Reference Temperature 

Reference temperature varies from one application to another. 



18 WeatherMasterÔ   
___________________________________________________________________ 

Columbia Weather Systems, Inc. 

Enter the start date for Degree-Day accumulation. 

Degree-Day accumulation for the season (from the start date) is 
displayed in the Temperature/Rain and Statistics screens. 

Wind Direction Offset: Allows the user to enter a degree offset to change 
the wind direction value. This feature is useful for vehicle or boat 
mounted systems. The offset is added to the actual wind direction value. 
For example, if the sensor output is 45º and the offset is 10º, then 
WeatherMaster will display 55º for the wind direction value. 

 

Orion Station Type: 

 

Location description and port settings can be edited. 

Pressure Offset: is the barometric pressure calibration offset. For 
example: 56 pressure offset will increase the barometric pressure 
reading by 0.56 in Hg. 

Altitude: is the elevation of the site being monitored. 0 ft is the default 
value set at the factory. This value should be changed to reflect the 
correct altitude of the site. The altitude setting will affect the barometric 
pressure reading. An increase of 10 feet will increase the pressure 
reading by 0.01 in Hg. 

Rain for the year offset: is used to correct the rainfall amount for the 
year. 

Wind Direction Offset: Allows the user to enter a degree offset to change 
the wind direction value. This feature is useful for vehicle or boat 
mounted systems. The offset is added to the actual wind direction value. 
For example, if the sensor output is 45º and the offset is 10º, then 
WeatherMaster will display 55º for the wind direction value. 
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Orion LX Station Type: 

 

Location description and server settings can be edited. 

If using Degree-Day, enter the reference temperature to be used in the 
calculations. The Degree-Day reference temperature must be entered in 
degrees F. 

Degree-Day = Average Temperature – Reference Temperature 

Web Site Station Type: 

 

Location description and server settings can be edited. 

If using Degree-Day, enter the reference temperature to be used in the 
calculations. The Degree-Day reference temperature must be entered in 
degrees F. 
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Degree-Day = Average Temperature – Reference Temperature 

Sensors (Capricorn/Pegasus only) 
In the Edit Weather Station dialog, select the Sensors tab. 

 

Select the sensors that are installed in the weather station. 

If temperature 1 is not selected, then wind chill, dew point and heat index 
will not be displayed. 

If relative humidity is not selected, then dew point, and heat index will not 
be displayed 

Note: Wind speed, wind direction, and barometric pressure are always 
installed in the software. 

Define the sensors connected to multi-purpose channels, X1 and X2. 
These channels are only available on the Capricorn 2000MP. Normally 
solar radiation is connected to X1 and soil moisture is connected to X2. If 
there aren’t any sensors connected to these channels, X1 and X2 sensor 
entries should be left blank. 

Reset Sensors: Click on this button to re-initialize Temperature 1 sensor. 
This feature is only applicable for weather stations with only one 
temperature sensor. 
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Station Properties (Capricorn/Pegasus only) 
In the Edit Weather Station dialog, select the Station Properties tab. 

 

The dialog will display all sensor calibration offsets and internal settings 
of the weather station. These settings are pre-configured at the factory. 

To change any of these settings, simply highlight the desired value and 
type in the new value. 

T1 through T4 Offsets: are the temperature calibration offsets found on 
the temperature probe cables in Capricorn or Pegasus weather stations. 
For the Orion weather station, T1 is the only relevant temperature offset. 
This offset can be used to adjust the temperature reading if desired.  

Pressure Offset: is the barometric pressure calibration offset. For 
example: 56 pressure offset will increase the barometric pressure 
reading by 0.56 in Hg. 

Altitude: is the elevation of the site being monitored. 0 ft is the default 
value set at the factory. This value should be changed to reflect the 
correct altitude of the site. The altitude setting will affect the barometric 
pressure reading. An increase of 10 feet will increase the pressure 
reading by 0.01 in Hg. 

Hi/Lo Interval: This setting determines how often a high (maximum) and 
low (minimum) record is stored in the data log of the Control Module.  
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Logging Interval: This setting determines how often a current value 
record of all sensors is stored in the data log of the Control Module.  

Select Save to Weather Station to save the changes without exiting the 
dialog. 

After changing the settings, select OK and the software will send the new 
values to the Control Module. 

Selecting Cancel will close the dialog without any changes taking effect. 

Please refer to the Weather Station User Manual for more information 
about calibration and settings values. 
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Data Logs (Capricorn/Pegasus only) 
(Not relevant in Orion, Orion LX and Web Site station types.) 

From the Configuration menu item, select Data Logs. 

 

The Control Module of the Capricorn 2000 weather station has a built-in 
data log that is continuously recording the values of sensors based on 
user defined interval. 

To manually download the data log and save it to the database, check 
“Read data logs now” and select OK. 

To delete the data logs in the Control Module after downloading it, check 
“Delete data logs when read”. 

Note: If the Control Module is also connected to other devices such as a 
modem or other computers, deleting the data log will prevent the other 
devices from accessing the data. 

Downloading a full data log will take about 1 to 2 minutes. The 
downloaded data will be incorporated in the software database. 

To change the data log recording intervals please refer to Weather 
stations/Station Properties section in the user manual. 
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Display 

Units of Measurements 
To set up the unit of measurement, select Display from the Options 
menu list. 

 

In the Units tab select the desired units for the temperature, wind, 
pressure, and rainfall parameters. 

The temperature unit selection will apply to all temperature readings, 
wind chill, heat index, dew point, and degree day. 

The rainfall unit selection will apply to all rain values and 
evapotranspiration. 
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Export Setup 
From the Options menu, select Export Setup. 

Data Export 
To configure WeatherMaster to export text data to a local computer or 
the Internet, select the Data Export tab from the Export Setup dialog. 
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Check the Enable Automatic Export box if you want WeatherMaster to 
automatically export the data. Select the desired export interval. The 
minimum interval is 5 minutes. 

Select the amount of data to be included in the text file by specifying the 
data period in hours. The minimum data period is one hour and the 
maximum period is 24 hours. 

Check the Export Column Name as First Line box if you would like 
WeatherMaster to include the column names in the first line. 

Select the data destination, local computer or FTP Host (Internet). 

If local computer is selected, enter the path of the directory (or folder) 
where the file will be saved. If the path is left blank, the file will be saved 
in the program folder. 

If FTP Host is selected, enter the FTP connection information. This 
information can be obtained from the FTP host provider. 

Manual Data Export 
To manually export text data, select Export Data from the File menu list. 

WeatherMaster will start the export process based on the setup in the 
Data Export dialog. 

Data File Format 
The first line of the data file may be a comma-delimited list of the field 
names, in the order represented by the values in each record. This line is 
optional. The rest of the file consists of comma delimited data records. 
Actual programmed parameter names will be output for optional sensors 
X1 and X2. Here is a sample of an output file with one record. 

Date,Time,"Peak Wind Speed","Ave. Wind Speed","Wind 
Direction",Rain,"Rel. Humidity","Bar. 
Pressure",Temp1,Temp2,Temp3,Temp4,"Leaf Wetness","Soil 
Moisture","Indoor Relative Humidity","Wind Chill","Heat Index","Dew 
Point" 

12/30/99,00:00,0,0,0,0,100,30.18,72.1,255,255,255,97.6,5,1.22,72.1,75,72.1 

One output file is generated for each weather station with the name 
nnntrh.txt, where nnn is the station serial number for the given station. 
The output files are optionally uploaded to an FTP server. See 
Options|Export Setup. 
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HTML Export 
To configure WeatherMaster to export an HTML file to a local computer 
or the Internet, select the HTML Export tab from the Export Setup dialog. 

 

Check the Enable Automatic Export box, if you want WeatherMaster to 
automatically export the data. Select the desired export interval. The 
minimum interval is 5 minutes. 

Select the amount of data to be included in the text file by specifying the 
data period in hours. The minimum data period is one hour and the 
maximum period is 24 hours. 

Check the Export Column Name as First Line box if you would like 
WeatherMaster to include the column names in the first line. 
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Select the data destination, local computer or FTP Host (Internet). 

If local computer is selected, enter the path of the directory (or folder) 
where the file will be saved. If the path is left blank, the file will be saved 
in the program folder. 

If FTP Host is selected, enter the FTP connection information. This 
information can be obtained from the FTP host provider. 

Manual HTML Export 
To manually export the HTML file, select Export HTML from the File 
menu list. 

WeatherMaster will start the export process based on the setup in the 
HTML Export dialog. 

HTML Template Format 
HTML Export requires customizing the file <sample.html>, which can be 
found in the directory where WeatherMaster is installed. Sample.html is 
an HTML file, in which special tags get replaced with the current 
parameter readings from weather stations. Values will be entered in the 
units specified in the WeatherMaster Display Options. One output file is 
generated for each weather station in the form of nnnsample.html, where 
nnn is the station serial number for the given station. The output files are 
optionally uploaded to an FTP server.  

The special tags have the following form: 

<#PeakWindSpeed> 
<#AveWindSpeed> 
<#WindDirection> 
<#Rain> 
<#RelHumidity> 
<#BarPressure> 
<#Temp1> 
<#Temp2> 
<#Temp3> 
<#Temp4> 
<#LeafWetness> 
<#X1> 
<#X2> 
<#WindChill> 
<#HeatIndex> 
<#DewPoint> 
<#ETYesterday> 

To replace the names for extra sensors, X1 or X2, with the appropriate 
names, use the following tags: 
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<#X1Name> 
<#X2Name> 
The replacement text for X1 or X2 names and values will be blank for 
those stations in which the sensors are not installed.  

To have the date or time included, use these tags: 

<#Date> 

<#Time> 

You can optionally include a Format=”***” parameter in the #Date or 
#Time tag. The Format string is used to program the exact type of date 
or time format desired. Here are some samples: 

<#Date Format=”mm/dd/yyyy”> 

<#Time Format=”tt”> 

The following is a complete list of options for date/time Format strings: 

Specifier  Displays  
nd Displays the day as a number without a leading zero 

(1-31). 
dd Displays the day as a number with a leading zero (01-

31). 
ddd Displays the day as an abbreviation (Sun-Sat) using 

the strings given by the ShortDayNames global 
variable. 

dddd Displays the day as a full name (Sunday-Saturday) 
using the strings given by the LongDayNames global 
variable. 

m Displays the month as a number without a leading 
zero (1-12). If the m specifier immediately follows an h 
or hh specifier, the minute rather than the month is 
displayed. 

mm Displays the month as a number with a leading zero 
(01-12). If the mm specifier immediately follows an h 
or hh specifier, the minute rather than the month is 
displayed. 

mmm Displays the month as an abbreviation (Jan-Dec) 
using the strings given by the ShortMonthNames 
global variable. 

mmmm Displays the month as a full name (January-
December) using the strings given by the 
LongMonthNames global variable. 

yy Displays the year as a two-digit number (00-99). 
yyyy Displays the year as a four-digit number (0000-9999). 
h Displays the hour without a leading zero (0-23). 
hh Displays the hour with a leading zero (00-23). 
n Displays the minute without a leading zero (0-59). 
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nn Displays the minute with a leading zero (00-59). 
s Displays the second without a leading zero (0-59). 
ss Displays the second with a leading zero (00-59). 
am/pm Uses the 12-hour clock for the preceding h or hh 

specifier, and displays 'am' for any hour before noon, 
and 'pm' for any hour after noon. The am/pm specifier 
can use lower, upper, or mixed case, and the result is 
displayed accordingly. 

a/p Uses the 12-hour clock for the preceding h or hh 
specifier, and displays 'a' for any hour before noon, 
and 'p' for any hour after noon. The a/p specifier can 
use lower, upper, or mixed case, and the result is 
displayed accordingly. 

/ Displays the date separator character given by the 
DateSeparator global variable. 

: Displays the time separator character given by the 
TimeSeparator global variable. 

Sample.html file can be modified/customized by the user to fit the look 
and feel of an existing web site. 
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Firewall Setup 
To configure the firewall properties, select the Firewall tab in the Export 
Setup dialog. 

 

If the network is not using a firewall, do not check the Use Firewall box. 

If a firewall is used, obtain information about your firewall from your 
network administrator. Depending on the type of firewall, you'll need the 
following information: 

Use Firewall: If you are behind a firewall host, make sure this is checked. 
You must insure that the firewall information has been correctly entered. 
You can specify a PORT to be used for the firewall. 

Firewall Type: Select the firewall type from the drop-down list. 
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Host Name: Specify the name or IP address of the firewall. 

Check the Authentication Required box if necessary. 

User ID: Enter the firewall User ID or leave blank if not used. 

Password: Enter the firewall password for the specified User ID or leave 
blank if not used. 

Port: Specify the firewall port. 
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Alarms 
WeatherMaster has the capability of setting an unlimited number of 
alarm conditions with each alarm having one or more notification 
method. 

To view the alarms dialog, select Alarms from the Option menu. 

Alarm Conditions 

 

To define an alarm condition, select the Add button under the Alarm 
Conditions window. 
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Enter a descriptive name for the alarm and select OK. 

The alarm condition name will be listed in the Alarm Conditions window. 

Select the name of the parameter. 

Define the upper and/or lower limits. 

Note: Only rainfall and barometric pressure parameters have a maximum 
rate of change settings and rising and falling conditions. 

Notifications 
WeatherMaster allows an unlimited number of notifications, which can be 
shared by multiple alarms. 

To define a notification, select the Add button at the bottom of the 
Notifications window. 

There are three types of notifications available: 

Popup Notification 

 

Enter a descriptive name for this notification and select Popup Only. 

A Popup notification will cause the computer to sound a tone when the 
alarm conditions are met. 
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Email Notification 

 

Enter the descriptive name for this notification and select Email. 

Enter the Sender Name. This should be the name of the person using 
WeatherMaster. 

Enter the Sender Email. This should be the email address of the person 
using WeatherMaster. 

Enter a subject line that WeatherMaster can use in the email. 

Enter the email address of the recipient. This can be the same as the 
sender’s email address, if the sender wishes to be notified. 

Enter the name of the Mail Server. To get the name of the server:  

1. From the Windows Start button, select Settings, then select Control 
Panel. 

2. In the Control Panel window, double click on the Mail icon. 

3. Select your email service and click on the Properties button. 

4. Select the Servers tab and you will see the name of the mail server 
next to the Outgoing Mail (SMTP). 

Click OK to close this window and all edits will take effect. 

Click Cancel to close the window and discard any edits. 
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Relay Control Notification 

 

The Relay Control notification feature is available in WeatherMaster with 
the addition of a USB 4 channel Relay Controller. Please contact 
Columbia Weather Systems for more information. 

Enter a descriptive name for this notification and select Relay Control. 

Select the desired relay to activate. Four relays are available, K0 through 
K3. 

Once an alarm condition is met, the selected relay will close momentarily 
and a popup window will be displayed. 

The Relay Controller is designed to activate a secondary latch relay with 
a user selectable timer.  

Click OK to close the Notification window and all edits will take effect. 

Click Cancel to close the window and discard any edits. 
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Alarm Condition 
Once an alarm condition has occurred, an Alarm Condition window will 
appear on the screen with a list of the alarms that have occurred with the 
date and time, name of the notification, name of the alarm, the value of 
the parameter and which limit has been violated. 

 

The software will continue to display this screen until the user clicks on 
the OK button to acknowledge the alarm information. 
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Operation 
Display Screen 

 

The Display screen presents the main parameters clearly using large text 
and a graphical wind rose. This screen is defined using an XML file that 
can be customized at the factory. 
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Wind Screen 

 

The Wind screen is dedicated to displaying wind information. This screen 
presents two wind charts: Vector Mean Chart and Wind Run Chart along 
with wind averages, peaks, and instantaneous values. 
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Vector Mean Chart:   

 

Displays the vector mean wind distance, vector mean wind direction and 
wind direction standard deviation for the last hour. In other words, this 
chart shows the distance and direction to which the wind has traveled in 
the last hour. 

The chart is self scaling based on wind speed. 

The related parameters are displayed in text as well as graphical format. 
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Wind Run Chart: 

 

Displays distance and direction the wind has traveled in the last hour for 
all 16 points around the compass. 

This chart is self scaling based on wind speed. 

Wind Averages  are displayed in this Wind screen in 3 second, 2 minute 
and 10 minute running average intervals. 

Wind Peaks  are displayed in this screen in 10 minute and 1 hour 
running intervals. 

Instantaneous wind  direction and speed are displayed and updated 
every second. 

The Wind screen is defined using an XML file that can be customized at 
the factory. 
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Temperature/Rain Screen 

 

The Temperature/Rain screen displays the current values for 
temperature and rain parameters and other auxiliary sensors and 
parameters. 

All four available temperature sensor values are displayed. If the system 
has only one temperature sensor connected, the values for temperature 
2, 3 and 4 will be blank. Only the Capricorn/Pegasus stations have 
multiple temperature sensor capabilities. 

Rain values are displayed for the day, week, month, and year. 

Evapotranspiration (ET) is displayed for the day prior. ET is calculated at 
midnight for the day. 

Evapotranspiration is calculated using the 1982 Kimberly-Penman 
formula as applied in the U.S. Bureau of Reclamation’s Pacific Northwest 
AgriMet Program. 

Degree Day (Season) is the degree day accumulation from the defined 
start date. The start date and base temperature setup can be found in 
Software Settings. 

Fuel moisture is displayed in 1-hour, 10 hours and 1000-hour fuel sticks. 
Fuel moisture is calculated based on the Nelson Fuel Moisture Algorithm 
and requires temperature, relative humidity, wind speed, solar radiation 
and rainfall data. 
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Status Bar 
The segmented bar at the bottom of the main window displays status for 
various operations including: 

1. Communications 

2. Database Access 

3. FTP Access 

4. Email Notification  

5. Pager Notification 

To preview the screen, select Print Preview from the File menu list. 

To print the screen, select Print from the File menu list. 
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Trend Screen 

 

The Trend screen displays a 24-hour graph of the selected parameter. 

The graph will display the 24-hour data from 12:00 PM to 12:00 PM (or 
current time). 

The graph is self-scaling based on the data values and the size of the 
graph window. 

To select a parameter, use the drop down arrow in the Parameter field 
and select the desired parameter. 

To graph data for another day, use the drop down arrow in the Date field 
and select the desired date from the calendar. 

Note: Once a date other than the current date is selected, the Min/Max 
and Statistics pages will also reflect that date. Once any of the Display 
screens are selected, all pages reset to the current date. 

To preview the screen, select Print Preview from the File menu list. 

To print the screen, select Print from the File menu list. 
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Min/Max Screen 

 

The Min/Max screen displays the minimum and maximum values for all 
the parameters including the time of occurrence for the day. 

To view min/max data for another day, use the drop down arrow in the 
Date field and select the desired date from the calendar. 

Note: Once a date other than the current date is selected, the Trend and 
Statistics pages will also reflect that date. Once any of the Display 
screens are selected, all pages reset to the current date. 

To preview the screen, select Print Preview from the File menu list. 

To print the screen, select Print from the File menu list. 
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Statistics 

 

The Statistics page displays daily and monthly statistics. 

For the current month, the monthly values are for the month-to-date. For 
a previous month, the monthly values are for the entire month. 

Degree Day value for the month is the degree day accumulation for the 
month. 

Evapotranspiration is in inches per day.  

Note: Not all parameters will have relevant daily or monthly values. In 
this case a dash (-) will be displayed to indicate that the information is 
not applicable. 

To view statistical data for another day, use the drop down arrow in the 
Date field and select the desired date from the calendar. 
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Note: Once a date other than the current date is selected, the Trend and 
Min/Max pages will also reflect that date. Once any of the Display 
screens are selected, all pages reset to the current date. 

To preview the screen, select Print Preview from the File menu list. 

To print the screen, select Print from the File menu list. 
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ALOHA Software Interface 
ALOHA (Area Locations of Hazardous Atmospheres) is software jointly 
developed by NOAA and EPA. This software is used to model and plot 
plumes of hazardous gases and chemicals by HazMat and Emergency 
Management teams. 

To predict how a pollutant cloud might disperse in the atmosphere, 
ALOHA needs information about weather conditions at the release site. 
WeatherMaster automatically transmits weather data in the ALOHA 
format every 30 seconds. 

WeatherMaster transmits the following data, also called SAM (Station for 
Atmospheric Measurements): 

ID = the station identification number 

VS = the vector mean wind speed, averaged over 5 minutes (in 
meters per second) 

WD = the vector mean wind direction, averaged over 5 minutes (in 
degrees true) 

SD = the standard deviation of the wind direction (in degrees) 

TA = the mean air temperature, averaged over 5 minutes (in °C) 

SP = the instantaneous wind speed (in meters per second) 

DI = the instantaneous wind direction (in degrees true) 

TI = the instantaneous air temperature (in °C) 

B = instantaneous SAM battery voltage (in volts) 

CHK = a checksum value 

Note: The weather stations do not measure battery voltage and therefore 
always transmit 0.00 volts for battery voltage. 

Interfacing ALOHA to WeatherMaster 
From the Configuration menu list in WeatherMaster, select Configuration. 

Check “Interface to ALOHA” to interface WeatherMaster with ALOHA 
(Area Locations of Hazardous Atmospheres) software. 

If there is more than one station installed, only the first station can 
interface with ALOHA. 
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Use the following procedure to successfully connect ALOHA to 
WeatherMaster: 

1. Close both ALOHA and WeatherMaster (if they are open). 

2. Open ALOHA software and click OK at the introductory window. 

3. Make sure a site location is defined in ALOHA. 

4. Minimize ALOHA window. 

5. Open WeatherMaster. 

6. After the station properties are read, wait for 30 seconds. 

7. In ALOHA, click on Setup/Atmospheric/SAM Station. 

 

8. Click Yes to communicate with the running application. 

9. Enter desired information in the “User Input for SAM Unit” 
window and click OK. 

10. Enter desired information in the “Cloud Cover and Humidity” 
window and click OK. 

11. Wait for about one minute while the software programs interface.  

12. ALOHA will display the weather data from WeatherMaster. 
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13. WeatherMaster will show ALOHA Active in the status bar. 

 

Note:  If ALOHA and WeatherMaster are not communicating 
WeatherMaster will show ALOHA Unavailable in the status bar and 
ALOHA will ask for a COM port when a SAM Station is selected. 

The main cause of this problem is the location of the NOAA_32.dll 
file. This library file enables the two applications to communicate. 
This file should reside only in the Windows folder. Perform a search 
to verify that the NOAA_32.dll file only exists in the C:\Windows 
folder (or equivalent.) If other copies of the NOAA_32.dll are found, 
simply rename then to NOAA_32.tmp. 
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Database 
WeatherMaster uses a Microsoft Access (97) format database to store 
weather data. 

Data collected from all weather stations is stored in the database every 
1-minute. 

To access the database for purposes of editing, exporting, creating 
queries, forms or reports, create a new database in Microsoft Access 
and link to the tables found in wmasterdata.mdb. To link to the tables, 
select the following in Access: File/Get External Data/Link Tables. 

Caution: Do not convert wmasterdata.mdb database to  newer 
formats of Microsoft Access. Once the database is c onverted, 
WeatherMaster will no longer be able to use the dat abase. 

Note: All sensor and parameter values are stored in the database using 
English units. 

Common Fields 
StationID A unique number identifying a weather 

station 

ParamIndex A value 0 to 15, indicating which 
sampled parameter the record 
represents 

DateTS Current date 

 
All temperatures are stored in Degrees F. 

Wind Speed is stored in MPH. 

Rain is stored in inches. 

Barometric Pressure is stored in In.Hg. 

Radiation is stored in w/m2. 



54 WeatherMasterÔ   
___________________________________________________________________ 

Columbia Weather Systems, Inc. 

Stations 
Purpose: To list weather stations in the system, including information 
necessary to calculate evapotranspiration and degree day from the 
DailyStatistics table. 

Primary Key: StationID 

Fields 

StationID 

Location Description indicating location of 
weather station 

DDRefTemp Degree Day Reference Temperature 

ETCropFactor Evapotranspiration Crop Factor 

Altitude Altitude for the weather station, in feet. 

Parameters 
Purpose: To list parameter names for each weather station.  

Primary Key: StationID, ParamIndex 

Fields 

StationID 

ParamIndex 

ParamName Name assigned to the given parameter. 
This value may vary from station to 
station for optional sensors. All standard 
parameter names will be the same for 
each station. 

Trend 
Purpose: To hold trend data sampled every minute. 

Primary Key: StationID, SampleTS 

Fields 

StationID 

SampleTS The date/time of the sample, provided 
by the weather station 

WindSpeed The peak wind speed detected during 
the 1 minute sample period 

AveWindSpeed The average wind speed for the 1 
minute sample period 
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WindDirection Wind Direction associated with the peak 
wind speed 

Rain Rainfall for the day 

RelHumidity Relative Humidity 

BarPressure Barometric Pressure 

Temp1 Temperature from temperature sensor 1 

Temp2 Temperature from temperature sensor 2 

Temp3 Temperature from temperature sensor 3 

Temp4 Temperature from temperature sensor 4 

LeafWetness Leaf Wetness 

X1 Optional sensor 1 

X2 Optional sensor 2 

WindChill Wind Chill 

HeatIndex Head Index 

DewPoint Dew Point 

MinMax 
Purpose: To hold daily min/max data 

Primary Key: StationID, DateTS, ParamIndex 

Fields 

StationID 

DateTS   

ParamIndex 

MinTS Time of day in which minimum occurred 

MinValue Minimum value for given parameter 

MaxTS Time of day in which maximum occurred 

MaxValue Maximum value for given parameter 
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DailyStatistics 
Purpose: To hold daily statistics 

Primary Key: StationID, DateTS 

Fields 

StationID 

DateTS  

AveRadiation Average radiation 

AveWindSpeed Average wind speed 

AveMeanTempDay Average of daily mean temperatures for 
last 3 days 

MinTemp Minimum temperature 

MaxTemp Maximum temperature 

MeanTemp Mean temperature 

MeanDewPoint Mean dew point 

UDegreeDay Degree Day, uncompensated (no 
reference temperature adjustment) 

UEvapotranspiration Evapotranspiration, uncompensated (no 
crop factor applied) 
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Troubleshooting 
Debug Window 
To view the communication between the weather station and 
WeatherMaster, select the Debug menu item from the Help menu list. 

 

On the left side of the tool bar, WeatherMaster has an indicator bar 
showing the communication status. If the bar is blank, there is no 
communication between the weather station and the software. If the bar 
has a moving blue area, there is a communication stream between the 
two. 

To stop the data stream between the weather station and the software, 
click on the Stop (Esc) button. In some instances, it might take few 
seconds for the stoppage to occur. If the data stream does not stop, click 
on the button again. 

To resume the data stream between the weather station and the 
software, click on the Resume button. 

Note that all the records are preceded by the station serial number, 400 
in this case. 
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The data displayed will differ from one station type to another. 
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Incorrect Temperature Readings (Capricorn/Pegasus 
Only) 
When using Capricorn or Pegasus weather stations, WeatherMaster has 
the capability of displaying four temperature readings. 

If the temperature reading is 255 °F (123.9 °C), th e temperature sensor 
is not installed or has not been properly initialized in the Control Module. 

Verify that the temperature sensor is installed, and then perform the 
temperature sensor initialization procedure. Please refer to the Capricorn 
2000 or Pegasus Weather Station User Manual for 
installation/initialization procedure. 

If only one temperature sensor is connected to the Capricorn or Pegasus 
station, the temperature sensor can be initialized using the Reset Sensor 
button in the Edit Weather Station/Sensors dialog. 
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User Support Information 
Technical Support 
Columbia Weather Systems, Inc. offers free technical support to users. 
Columbia Weather Systems, Inc. reserves the right to revoke this policy 
at any time and charge a reasonable fee per hour for phone support. 

For technical support: 

Phone: 1 503 629-0887 

Fax: 1 503 629-0898 

Email: info@columbiaweather.com 

Office hours are 8:30 AM to 4:30 PM Pacific Time, Monday through 
Friday. 

Software License 
This Software is protected by copyright laws and international copyright 
treaties, as well as other intellectual property laws and treaties. The 
Software is licensed, not sold. 

You may install and use one copy of the Software on the Computer. 

Limited Warranty 
COLUMBIA WEATHER SYSTEMS, INC. WARRANTS THAT, FOR A PERIOD 
OF NINETY (90) DAYS FROM THE DATE OF DELIVERY TO YOU AS 
EVIDENCED BY A COPY OF YOUR INVOICE OR RECEIPT, THE MEDIA ON 
WHICH THE SOFTWARE IS FURNISHED UNDER NORMAL USE WILL BE 
FREE FROM DEFECTS IN MATERIALS AND WORKMANSHIP. EXCEPT FOR 
THE ABOVE EXPRESS LIMITED WARRANTIES, COLUMBIA WEATHER 
SYSTEMS, INC. MAKES, AND YOU RECEIVE, NO WARRANTIES, EXPRESS, 
IMPLIED, STATUTORY, OR IN ANY COMMUNICATION WITH YOU; AND 
COLUMBIA WEATHER SYSTEMS, INC. SPECIFICALLY DISCLAIMS ANY 
OTHER WARRANTY INCLUDING THE IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
COLUMBIA WEATHER SYSTEMS, INC. DOES NOT WARRANT THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR 
FREE. If this Software was purchased in the United States, the above exclusions 
may not apply to you since some states do not allow the exclusion of implied 
warranties. In addition to the above warranty rights, you may also have other 
rights, which vary from state to state. 

Limitation of Liability 
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IN NO EVENT WILL COLUMBIA WEATHER SYSTEMS, INC. BE LIABLE FOR 
ANY DAMAGE, WHETHER ARISING FROM TORT OR CONTRACT, 
INCLUDING LOSS OF DATA, LOST PROFITS, COST OF COVER, OR OTHER 
SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR INDIRECT DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM OR 
ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY 
THEORY OR LIABILITY. THIS LIMITATION WILL APPLY EVEN IF COLUMBIA 
WEATHER SYSTEMS, INC. OR ANY AUTHORIZED DEALER OR RESELLER 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU 
ACKNOWLEDGE THAT THE LICENSE FEE REFLECTS THIS ALLOCATION 
OF RISK. If you purchased this program in the United States, the above limitation 
may not apply to you because some states do not allow the limitation or 
exclusion of liability for incidental or consequential damages. 

Remedies 
The entire liability of Columbia Weather Systems, Inc. and your exclusive remedy 
under the warranty provided herein will be, at the option of Columbia Weather 
Systems, Inc., to attempt to correct or work around errors, to replace the media, 
or to refund the purchase price and terminate this Agreement. This remedy is 
subject to return of the Software to Columbia Weather Systems, Inc. or to the 
Authorized Dealer or Reseller from whom it was obtained along with a copy of 
your invoice or receipt. 
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Reference 
Glossary 

Self-Aspirating Radiation Shield 
A device used to shield a sensor such as a temperature or humidity 
probes from direct and indirect radiation and rain while providing access 
for ventilation. 

Barometric Pressure 
The pressure exerted by the atmosphere as a consequence of 
gravitational attraction exerted upon the “column” of air lying directly 
above the point in question. 

Celsius Temperature Scale 
A temperature scale with the ice point at 0 degrees and the boiling point 
of water at 100 degrees. 

Dew Point 
The temperature to which a given parcel of air must be cooled at 
constant pressure and constant water-vapor content in order for 
saturation to occur. When this temperature is below 0°C, it is sometimes 
called the frost point. 

Fahrenheit Temperature Scale 
A temperature scale with the ice point at 32 degrees and the boiling point 
of water at 212 degrees. 

Global Radiation 
The total of direct solar radiation and diffused sky radiation received by a 
unit horizontal surface. Global radiation is measured by a pyranometer. 

Heat Index 
The heat index or apparent temperature is a measure of discomfort due 
to the combination of heat and humidity. It was developed in 1979 and is 
based on studies of evaporative skin cooling for combinations of 
temperature and humidity. 
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Pyranometer 
Measures the combined intensity of incoming direct solar radiation and 
diffused sky radiation. The pyranometer consists of a radiation-sensing 
element, which is mounted so that it views the entire sky. 

Relative Humidity 
Popularly called humidity. The ratio of the actual vapor pressure of the 
air to the saturation vapor pressure. 

Sea Level Pressure 
The atmospheric pressure at mean sea level, either directly measured 
or, most commonly, empirically determined from the observed station 
pressure. 

In regions where the earth’s surface pressure is above sea level, it is 
standard observational practice to reduce the observed surface pressure 
to the value that would exist at a point at sea level directly below. 

Soil Moisture 
Moisture in the soil within the zone of aeration present in the soil pores. 
In some cases this refers strictly to moisture within the root zone of 
plants. 

Solar Radiation 
The total electromagnetic radiation emitted by the sun. 99% of the suns 
energy output falls within the wavelength interval from 0.15 microns to 
4.0 microns, with peak intensity near 0.47 microns. About one-half of the 
total energy in the solar beam is contained within the visible spectrum 
from 0.4 to 0.7 microns, and most of the other half lies near infrared, a 
small additional portion lying in the ultraviolet. 

Wet Bulb Globe Temperature (WBGT) 
Is a composite temperature used to estimate the effect of temperature, 
humidity, and solar radiation on humans. 

Wind Chill 
That part of the total cooling of a body caused by air motion. 
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Unit Conversion 

Speed 
Kilometers per hour = 1.610 x miles per hour 

Knots = 0.869 x miles per hour 

Meters per second = 0.448 x miles per hour 

Feet per second = 1.467 x miles per hour 

Temperature 
Temperature in °C = 5/9 (temperature in °F - 32) 

Temperature in °F = (1.8 x temperature in °C) + 32 

Distance 
Millimeters = 25.4 x inches 

Centimeters = 2.54  x inches 

Pressure 
Millibars = 33.86 x inches of mercury 

Kilopascals = 3.386 x inches of mercury 

Pounds per square inch = 0.49 x inches of mercury 

Standard atmospheres = 0.0334 x inches of mercury 

Solar Radiation 
BTU/foot2 minutes = 0.00529 x watts/meter2 

Joules/centimeter2 minutes = 0.006 x watts/meter2 

Mega joules/meter2 day = 11.574 x watts/meter2 

Langleys/minutes = 0.00143 x watts/meter2 
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Tables and Formulas 

Wind Chill Chart 

In 2001, NWS implemented an updated Wind chill Temperature (WCT) 
index. The change improves upon the former WCT Index used by the 
NWS and the Meteorological Services of Canada, which was based on 
the 1945 Siple and Passel Index. 

In the fall of 2000, the Office of the Federal Coordinator for 
Meteorological Services and Supporting Research (OFCM) formed a 
group consisting of several Federal agencies, MSC, the academic 
community (Indiana University-Purdue University in Indianapolis (IUPUI), 
University of Delaware and University of Missouri), and the International 
Society of Biometeorology to evaluate and improve the windchill formula. 
The group, chaired by the NWS, is called the Joint Action Group for 
temperature Indices (JAG/TI). JAG/TI's goal is to upgrade and 
standardize the index for temperature extremes internationally (e.g. Wind 
chill Index). 

The current formula uses advances in science, technology, and 
computer modeling to provide a more accurate, understandable, and 
useful formula for calculating the dangers from winter winds and freezing 
temperatures.  
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Wind Chill Equation 
WC = 35.74 + 0.6215 T -35.75(V0.16) + 0.4275 T(V0.16) 

Where: 

WC = wind chill temperature in °F 

V = wind velocity in mph 

T = air temperature in °F 

Note:  Wind chill Temperature is only defined for temperatures at or 
below 50 degrees F and wind speeds above 3 mph. 
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Heat Index 
 

 Temperature in °F 

RH 70 75 80 85 90 95 100 105 110 115 120 125 130 135 

0 64 66 73 78 83 87 91 95 99 103 107 111 117 120 

5 64 69 74 79 84 88 93 97 102 107 111 116 122 126 

10 65 70 75 80 85 90 95 100 105 111 116 123 131  

15 65 71 76 81 86 91 97 102 108 115 123 131   

20 66 72 77 82 87 93 99 105 112 120 130 141   

25 66 72 77 83 88 94 101 109 117 127 139    

30 67 73 78 84 90 96 104 113 123 135 148    

35 67 73 79 85 91 98 107 118 130 143     

40 68 74 79 86 93 101 110 123 137 151     

45 68 74 80 87 95 104 115 129 143      

50 69 75 81 88 96 107 120 135 150      

55 69 75 81 89 98 110 126 142       

60 70 76 82 90 100 114 132 149       

65 70 76 83 91 102 119 138        

70 70 77 84 93 106 124 144        

75 70 77 85 95 109 130 150        

80 71 78 86 97 113 136         

85 71 78 87 99 117 140         

90 71 79 88 102 122 150         

95 71 79 89 105 126          

100 72 80 90 108 131          
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Dew Point 
B = (Ln (RH/100) + ((17.2694*T) / (237.7+T))) / 17.2694  

Dew Point in °C = (238.3 * B) / (1-B)  

Where:  

RH = Relative Humidity 

T = Temperature in °C 

Ln = Natural logarithm 

B = Intermediate variable 

Evapotranspiration 
The 1982 Kimberly-Penman equation: 

l ETx=(D/(D+g))(Rn-G)+(g/(D+g)) 6.43 Wf (es-ea) 

The Penman equation is known as a “combination equation” because it 
combines net radiation (the heat function) and advective energy transfer 
(the wind function) into one energy balance equation. 

Wet Bulb Globe Temperature (WBGT) Approximation 
The approximation used by the Australian Bureau of Meteorology does 
not take into account variations in the intensity of solar radiation or of 
wind speed, and assumes a moderately high radiation level in light wind 
conditions. 

Use of this approximation may lead to incorrect estimates of thermal 
stress, particularly in cloudy and windy conditions. Under these 
conditions the approximation is likely to lead to an overestimate of the 
stress. The approximation will also overestimate night-time and early 
morning conditions when the sun is low or below the horizon. 

The simplified formula is: 

WBGT = 0.567 x Ta + 0.393 x e + 3.94 

Where: 

Ta = Dry bulb temperature in (°C) 

e = Water vapor pressure (hPa) [humidity] 

The vapor pressure can be calculated from the temperature and relative 
humidity using the equation: 

e= rh/100 x 6.105 x exp (17.27 x Ta / (237.7 + Ta)) 

 

Where: 
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rh = Relative Humidity (%) 

Source: American college of Sports Medicine, Prevention of thermal 
injuries during distance running – Positon Stand. Med.J.Aust. 1984 Dec. 
876 
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